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1 IT Reconstruction

1.1 Welcome

We congratulate you on your purchase of IT Reconstruction, and thank you for it which you decided for
one of our products. 
With the IT Reconstruction it is possible to regain lost or non up-to-date ETS project data by reading out
the plant.
The IT Reconstruction discovers all the devices connected to the Bus and collects all the data from the
relevant storage.

The available functions in IT Reconstruction may be restricted by the used ETS3 license. In addition you
find further details in the on-line help of the ETS3.

Knowledge of Windows and ETS3 is necessary for an understanding of the contents described.

IT Reconstruction Features

How to ...

Reconstruct an EIB/KNX installation (Reverse Engineering)

Compare an EIB/KNX installation with an ETS project

Windows

Main Window

Menu commands

File Menu

Edit Menu

Scan Menu

Reconstruct Menu

Help Menu

Additional Information

Contact (Orders, Hotline)
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1.1.1 Imprint

The information and data contained in this document are subject to change without prior notice. The
names and data used in examples are fictitious if not noted otherwise. You may not reproduce or copy
this document, or any portion thereof, for any purpose without the explicit written consent of IT GmbH,
regardless of the mode and means, electronically or mechanically.

Copyright © 1995-2015

IT Gesellschaft für Informationstechnik mbH
An der Kaufleite 12
D-90562 Kalchreuth
Germany

All rights reserved.

Windows is a trademark of the Microsoft Corporation.

EIB and ETS are registered trademarks of KNX Association c.v.b.a.

1.1.2 Contact

Orders
For information and orders please contact our sales office:

Phone: +49 (0) 911 518349-0 (Mo-Fr 9 a.m. to 16 p.m.)
Fax: +49 (0) 911 5183688
Email: vertrieb@it-gmbh.de

Hotline Service
If you have questions or problems, you may contact our Hotline:

Phone: +49 (0) 911 518349-10 (Mo-Fr 9 a.m. to 4 p.m.)
Fax: +49 (0) 911 5183688
Email: hotline@it-gmbh.de
WEB: problem report

IT GmbH 
An der Kaufleite 12 
D-90562 Kalchreuth
http://www.it-gmbh.de
Germany

1.1.3 Demo version and Licensing

This software is protected by a WIBUKEY dongle. Without dongle, the software runs in demo mode, with
the following restrictions:

No Project files can be loaded or saved.

Only devices in the address range 1.1.1 to 1.1.10 are read and reconstructed.

The read data can only be reconstructed into a new project 

the function "Update Project" is not available.

For information and orders please contact our sales office (see Contact).

For information about WIBUKEY and in case of WIBUKEY related questions you may also contact 

mailto:vertrieb@it-gmbh.de
mailto:hotline@it-gmbh.de
http://www.it-gmbh.de/en/support/service/feedback.html
http://www.it-gmbh.de
http://www.wibu.de
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WIBU-SYSTEMS AG.

1.1.4 Feedback

Please help us to improve IT Reconstruction. Your feedback may influence further development so that in
subsequent IT Reconstruction versions and manual editions your wishes and requirements may be taken
into consideration. We look forward to receiving your comments and wishes on the content,
representation of associations as well as comprehensibility regarding IT Reconstruction program parts or
documentation. Please also let us know if you have any improvement suggestions with regard to support,
training or sales. 

Feedback via IT Website

1.1.5 Conventions

The following conventions were used for this manual:

Bold print either highlights important terms, denotes a menu command or pressing a button.

Italic print indicates a variable text, e.g. Project file indicates that the name of your project file
is meant here.

> and >> the symbol > in a brief description denotes an operational sequence. In front of the
sequence symbol > there may be a site specification e.g. main menu or context menu. 
Example: main menu > Edit > Properties properties-page > General means that in the main menu
you should first select the Edit menu command and in it the Properties command, then proceed in
the dialog which has opened up to the General properties page. 
If a double mouse click is necessary the sequence symbol will be doubled >>. The terms left/right
mouse button refer to the standard Windows setting.

Screen images and operating sequences refer to a Windows XP operating system. If you use another
operating system, your display or operation may deviate from the illustrations in this manual.

This manual is intended both for beginners as an introduction to proper use and experienced users as a
reference work. These two aims are to be achieved by dividing into categories. Four symbols indicate the
categories:

The building blocks indicate the path to „basic knowledge“.

The flash guides to „quick creation“.

Here you find „tips and tricks“.

The magnifier shows „in-depth“ topics.

1.1.6 Features

IT Reconstruction helps you to reconstruct lost or outdated ETS project data by reading the programmed
devices.
IT Reconstruction discovers all devices present on the bus and reads the relevant memory ranges. Using
the product data for the devices, it then tries to create an ETS project that would lead to exactly the read
device data.

Area of application

http://www.wibu.de
http://www.it-gmbh.de/en/support/service/feedback.html
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Recovery of lost ETS project data

Update of outdated ETS project data

Extension of unknown installations

Creation of data for visualization (e.g. for Elvis, EIBA OPC Server)

This data can be recovered

This data is not programmed into the devices and therefore cannot be

recovered

Restrictions

In some cases, reconstruction might fail or finish incomplete:

Devices locked with an unknown BCU password cannot be read.

Devices that are programmed with an ETS Plug-in, can be read and reconstructed only if the
device manufacturer supports this (by a corresponding Reconstruction Plug-in).

Some application programs contain parameters that are not programmed into the device (e.g.
comments for documentation). These functionally ineffectual parameters can therefore not be
recovered.

It is possible that application programs exist with complex parameter interdependencies that
cannot be resolved by IT Reconstruction (the message "Parameter reconstruction incomplete" will
appear). Please contact our Support in this case, we will then try to find a solution.

1.1.7 System requirements

You can use this software only together with the EIB/KNX Engineering Tool Software ETS 3.0c or
higher.

Os operating systems, Windows 2000/XP/Vista are supported.

The software uses less than 1MByte space on the hard disk.

1.1.8 New in Version 2.1 ans 2.2

The following functions are new or improved in version 2.1.
If you have licensed Reconstruction 2.0, the functions marked with (*) are not available. You may
upgrade the license to version 2.1 in this case. Please contact our sales office (see Contact).

1 Reconstruction of individual devices (*)

1. 1 Selection of devices to read out / reconstruct
After scanning device you may select the devices for read out or reconstruction by check boxes. 
Hint: the check boxes are only visible if Reconstruction 2.1 is licensed (not in demo mode or with a
version 2.0 license)

1.2 Manual Address input
You may skip the Scan Devices step if you know the device address. 
The topology must already be created (by scanning or manual input). Then select the line and perform
the menu command "Add device".

http://www.it-gmbh.de/deutsch/products/
http://www.it-gmbh.de/deutsch/products/
http://www.eiba.com/home.nsf/2002/tools/english/opc?openframeset
http://www.eiba.com/home.nsf/2002/tools/english/opc?openframeset
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2 Improvements in the Reconstruction algorithm

Some devices that modify their memory during operation are now handled specifically. This avoids that
spurious differences are displayed and improves the reconstruction result.

3 Display of missing product data

If product data are missing in the database and therefore devices cannot be reconstructed, this is now
displayed clearly in a list.

4 Automatic Import of product data (*)

Since Version 2.2.291, missing product data can be imported from within the Reconstruction software.
See Products Page.

1.2 Procedures

1.2.1 Launching Reconstruction

IT Reconstruction integrates itself as button  in the ETS 3 toolbar.
When starting ETS the first time after installing IT Reconstruction, the toolbar button is created on a new
floating toolbar; you may simply drag this on the main toolbar of ETS 3 with the mouse.

Click on the toolbar button to start Reconstruction.

ETS 3 Add-ins
The setup installs IT Reconstruction as ETS 3 add-in. You may view, activate or deactivate all
installed add-ins within ETS 3 using the menu command Extras > Add-ins (the command is
visible only if at least one add-in is installed).

1.2.2 Project file

The current state of IT Reconstruction (scanned areas, lines and devices, read device data) can be saved
at any time into a file and loaded later to continue work. Use the commands in the File Menu for this
task.

The IT Reconstruction project files have the file extension ".prj".

 Project files
You cannot import the *.prj files with ETS 3.

1.2.3 Reconstruct an ETS project

Using IT Reconstruction, you can create an ETS project from an existing installation. This is useful if no
ETS project is available at all.



IT Reconstruction 8

© 1995 - 2015 IT Gesellschaft für Informationstechnik mbH

Also, you can update an existing ETS project with data read from the installation. This is useful, if an
ETS project is available but does not reflect the current status (e.g. an outdated backup copy).

The following pages will guide you through the process of reconstructing a project. During the process,
you can save at any time the current data into a project file and load it again later.

 Reconstruction will run faster if you close all ETS windows before starting it.

When done, you may edit the created project with ETS:

Enter meaningful names for lines, devices and group addresses.

Create a building structure and assign the devices to rooms.

Reconstruction tries to assign to each found application program (software) a suitable product
(hardware). For one application program there may exist more than one product in the database.
You may correct the assignment done by IT Reconstruction manually in ETS. Note that a product
assignment not reflecting the real product has no adverse effect on functionality.

1.2.3.1 1. Define Topology

Initially, the topology (area/line structure) must be created. This is done on the Topology page of the
main window.
IT Reconstruction offers two methods which can also be combined.

Scan topology from installation

How it works

IT Reconstruction scans the installation for line and backbone couplers and derives the possible areas
and lines from this information.

Prerequisites

As for all bus functions, it is important that the individual address of the gateway is set correctly (suitable
to the line connected, no collission with other addresses).

Option 1: Connect a RS232/USB module to a flush-mounted BCU already existing in the
installation. Then you automatically have a correct gateway address.

Option 2: If you connect your own gateway to the installation, first determine the line address (e.g.
by by pressing the programming button on another device on the same line and reading the
address using ETS - result: area.line.dev). Then set the gateway address to e.g. area.line.254,
scan the line area.line in ETS and and finally set the gateway address to a free address.

Procedure

Select the "Scan Topology" command from the Scan menu or click on the corresponding button.

Scanning the topology may take several minutes; you can abort the operation at any time.

Enter topology manually

It is possible (e.g. if the topology is known) to enter areas and lines 
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manually:

Select the "Add Area" command from the Edit menu. A new area is added; you can edit the
automatically assigned area address immediately.

Select an area in the list and add a new line by the "Add Line" command from the Edit menu. You
can edit the automatically assigned line address immediately.

If you accidentally created an area or line, you can remove it using the "Delete" command from the
Edit menu.

1.2.3.2 2. Scan Devices

After the topology has been defined, IT Reconstruction can search for the devices connected to some or
all lines.

How it works

IT Reconstruction  scans through all possible device addresses 1-255 in the selected lines. If a
device is found at an address, the mask version and the Application Program ID are read to identify the
device.

Prerequisite

As for all bus functions, it is important that the individual address of the gateway is set correctly (suitable
to the line connected, no collision with other addresses).

Procedure

 Mark the lines to be scanned.

Select "Scan devices" from the Scan menu or click on the corresponding button.

Scanning the devices may take several minutes; you can abort the operation at any time.

Hint: The scanning process creates a considerable bus load on the affected lines. This gets worse
by the fact that this function by its nature also tries to contact non-existing addresses which leads to
corresponding repetitions.
If you experience problems (e.g. with line/backbone couplers), you can limit the bus load by scanning
the installation line by line or at least area by area, and connecting the PC directly to the line (main line)
to be scanned.

No devices found?

1.2.3.3 3. Check product data

After scanning the devices it is known which application programs are used in the installation. You can
find a list on the Product Page in the main window.

IT Reconstruction searches the ETS product data automatically for matching products. You should now
check the product list for entries with Status "Missing". These devices cannot be reconstructed, and
may be not even read, if you do not import a suitable product database now.
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Where do I find suitable product data?

Why does Reconstruction need product data for reading devices?

1.2.3.4 4. Read Devices

In this step, IT Reconstruction reads the relevant data from all found devices.

Procedure

Select "Read Devices" from the Scan menu or click on the corresponding button.

Reading the devices may take a very long time; you can abort the operation at any time.

Why can't devices be read out?

1.2.3.5 5. Create/update project

This is the last step in recovering an ETS project.
You may create a new project or update an existing project.

Create new project
This is useful, if no ETS project is available.
A new ETS project is created containing all read areas, lines, devices with parameter settings and group
addresses.

Update existing project
Choose this method if an ETS project is available, but outdated. You may also use this method to
reconstruct a project in several iterations by reading only a part of the installation, creating a new project
in the first round and updating it stepwise for more parts.

Note that update overwrites the original data. Consider making a backup copy first.

During project update names, comments and other data are preserved, all newly discovered areas, lines,
devices and group addresses are added, and parameters and group address assignments are updated.
Areas, lines, devices and group addresses present in the ETS project, but not in the installation are not
deleted.

Procedure

To create a new project, select the "Create new project" command from the Reconstruct menu and enter
a project name.
To update an existing project, first select a project by clicking on the "Select..." button, then use the
"Update project" command from the Reconstruct menu.
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Output during reconstruction

During reconstruction, progress, warning and error messages are written to the Output window.

1.2.4 Compare

You can use IT Reconstruction to compare an EIB/KNX installation with an existing ETS project. This is
useful to

verify the identity of design and installation (e.g. for acceptance)

analyze problems which are otherwise difficult to find

Execute steps 1 to 4 as described for reconstructing a project.

Select an ETS project using the "Select..." button in the main window

Select the "Compare Project" command from the Reconstruct Menu.

If differences are discovered, these are written to the Output window. The comparison may take a very
long time; you can abort the operation at any time.

1.3 Reference

1.3.1 Windows

1.3.1.1 Main window

In the main window, the following information is displayed:

Current ETS Project.

Select an ETS project for Update or Comparison using the "Select..." button

Topology Page and Product Page

Output window

1.3.1.2 Topology Page

This page displays all areas, lines and devices found in the installation.

Areas and Lines (left pane)

On the left, the bus topology is displayed. After the area and line addresses, the number of contained
devices is displayed in [] brackets.
The topology definition is always the first step when using IT Reconstruction. IT Reconstruction may 
scan the topology from the installation or you may create/edit the topology manually.

Devices (right pane)

On the right, all devices in the selected line are displayed. The individual columns are:

Address Individual address (device address)

Status Indication whether or not the device data is already read.

Mask Version Mask version of the device

Application Program Application Program ID of the device; if the corresponding product data is
available in the ETS database, the name of the application program is
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displayed.

Buttons

Scan Topology (also available in the Scan Menu):
Determines the topology of the installation by searching for line couplers.

Scan Devices (also available in the Scan Menu):

Searches for all devices in the lines marked with . In this step, the individual address, the mask
version and the Application Program ID are read.

Read Devices (also available in the Scan Menu):
Reads the relevant memory data from all devices.

1.3.1.3 Products Page

On this page, the application programs found in the installation are displayed.
The individual columns are:

Status Indicates whether or not product data for this application program are available
in the ETS database:
OK Product data is present.
No Product
assigned

The application program is present, but no product has been
selected. Double-click the entry and select a product in the 
product selection dialog.

Import
available

The product data are not present in ETS, but can be imported.
Click on "Import missing products", to start the import (see 
Dialog Import Product Data).

Missing The product data are not present in ETS and are not available for
import, too. Get a suitable product database (see Where do I
find suitable product data?) and import it into ETS.

Manufacturer Manufacturer of the application program. If a number instead of a name is
displayed here, the manufacturer is (currently) not known in the ETS database.
Ask our Support for a current list of manufacturer codes.

Application ID Application program ID of the device.

Application name Name of the application program, if found in the database.

Product Name of the assigned Product (hardware).

If there are rows with status "Missing" or empty product name, you should import the current product
databases of the manufacturers before continuing.
A complete reconstruction is only possible if the status of all application programs is "OK" and all
application programs are assigned to a product.
Some application programs may be assigned to more than one product. You may select another
possible product by double-clicking at the item and opening the product selection dialog.

1.3.1.4 Dialog Device Details

This dialog displays all data read from the device. You may open the dialog by double-clicking on a
device in the Topology Page.
On the left side, select the information category to be displayed. On the right side the read data is
shown.

General Individual Address, Mask Version und Application Program ID.

Group
Communication

Contents of the address, association and object table, in case of couplers the
filter table.

Polling Polling master und polling slave tables.
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Communication

Parameter
   Memory type
      Range

Contents of the read memory as hex dump.

1.3.1.5 Dialog Product Selection

This dialog displays all possible products which can be assigned to the application program. You may
open the dialog by double-clicking on an item in the Product Page.

The individual columns are:

Name Name of product

Order Id Order Id of product.

To change the assigned product entry select another entry and click OK to save.

1.3.1.6 Dialog Import Product Data

If some product data is currently not available in the ETS database, it has to be imported before the
device can be read or reconstructed.
With IT Reconstruction, a CD containing most of the products that were ever available for ETS 2 and ETS
3 is delivered. Data from this CD can be imported automatically via the Import Product Data dialog.

How to use

The dialog can be opened from the Products Page by clicking on "Import missing products".
It lists the names of the individual product files (VD4) that should be imported.
Determine the files to import by putting a check mark before the files, then click the Import button.

About the product library

For each application program, there is one VD4 file, named mmddddvv.vd4, where

mm is the manufacturer code, as 2-digit hexadecimal number

dddd is the application program number ("device type")  as 4-digit hexadecimal number

vv is the application program version as 2-digit hexadecimal number

For better overview, all VD4 files from one manufacturer are located in a directory starting with mm (the 2-

digit manufacturer code).

The file named mmddddvv.vd4 may also be a shell link to the real VD4 file. This saves space in the

case where more than one application program is contained in one VD4 file.

You may copy the product library to a hard disk or network drive for faster access and to add own VD4
files (keep the naming scheme!). Specify the product library location in the Options dialog.

The product library is provided only to help you in reconstructing projects. Please do not use it
for creating new projects since it also contains outdated product data. Always use the current
product databases from the manufacturer for your normal work.

1.3.1.7 Dialog Options

Here you may add up to two paths where IT Reconstruction will search for missing product data.
Please note the naming convention for product data files (see: dialog Import Product Data)
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1.3.2 Commands

1.3.2.1 File Menu

The File menu contains the following commands:

New Clears all data.

Open Opens a Project file.

Save Saves all read data in the Project file.

Save As Saves all read data in another file.

Print Preview Formats the contents of the current page as print preview.

Print Prints the contents of the current page on the standard printer.

Options Opens the option dialog where pathes for import product data can be set.

Close Closes IT Reconstruction and returns to ETS.

1.3.2.2 Edit Menu

The Edit menu contains the following commands:

Add Area For manually adding a new area on the Topology Page.

Add Line For manually adding a new line on the Topology Page.

Add Device For manually adding a single new device on the Topology Page.

Delete For manually deleting the selected area/line in the Topology Page.

1.3.2.3 Scan Menu

The Scan menu contains the following commands:

Scan Topology Scans the topology structure of the installation and adds the found areas and
lines in the Topology Page.

Scan Devices Scans for all devices in the lines marked with  in the Topology Page. In this
step the individual address, the mask version, and the Application Program ID
are read.

Read Devices Reads the relevant memory data from all devices.

1.3.2.4 Reconstruct Menu

This menu contains functions to synchronize the data read from the device with an ETS project. The ETS
project to use is displayed at the top of the Main window.

The Reconstruct menu contains the following commands:

Update Project Updates the current ETS project.
Create New Project Prompts for the name of a new project. Otherwise same function as

Update Project.
Compare to ETS Project Compares the read data with the current ETS project.

1.3.2.5 Help Menu

The Help menu contains the following commands:
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Search Search in the help system

About Displays program information, version number and copyright.

1.3.3 Messages

1.3.3.1 Output window messages

In the output window, for each difference found during Update or Compare a message is emitted:

Missing type addr / Added type addr:
(type: area, line, device, main group, middle group)

Device addr: different application program (device: id, project: id):
The device in the installation has a different application program than the device in the ETS project.

Comm. Object no: different length (device: n bits, project: n bits):
The type of the communication object is different. This is normally a side effect of different
parameter settings.

Comm. Object no: different priority (device: prio, project: prio):
The object priority is different.

Comm. Object no: different flags (device: flags, project: flags):
The object flags are different (C=Communication, R=Read, W=Write, T=Transmit, U=Update).

Comm. Object no: different group addresses (device: gas, project: gas):
The group addresses assigned to the communication object are different.

Parameter '%ls': different value (device: 'value', project: 'value'):
The value of the given parameter is different.

... more differences ...:
If more than 10 differences are found for a device, this message appears and all following output for
this device is suppressed.

In addition, the following error messages may appear:

device addr: no product data:
The device could not be read, reconstructed or compared, because no product data is available.

device addr: Read Parameters possibly incomplete (no product data available):
The device could not be read at least partially. But because no product data is available, it is not
sure if all parameter data have been read. 
Reconstruction of the device might fail.

For simple BCU1 based devices without external processor this message can generally be ignored.

device addr: Reading Group Communication data failed (cause):
An error occurred when reading group communication data.

device addr: Reading Parameters failed (cause):
An error occurred when reading parameter data.

Failed to set Parameter 'param' = 'value' (cause):
When updating the ETS project, a parameter value could not be set.

device addr: Warning: Parameter reconstruction incomplete:
IT Reconstruction did not succeed in finding a combination of parameter values consistent with the
data read from the device. Possible reasons include:

The device has not been programmed completely.

The device uses a manufacturer-specific ETS Plug-in. Such devices can only be reconstructed
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if the device manufacturer supplies a corresponding Plug-in for Reconstruction.

The device has an extremely complex parameter structure.

1.4 Questions and Answers

1.4.1 Why no devices are found?

Possible causes:

The individual address of the data interface as configures in ETS does not match the line where
the interface is connected (e.g. local address 1.1.250 on line 1.7). 

The line address can be determined e.g. by putting a device on the same line into programming
mode and read its address with the ETS function Diagnostics/Individual Addresses.

What to do: configure a correct address for the data interface.

A device in the installation has the same individual address as the data interface. . 

You can check this in ETS (since ETS 3.0d) in Extras/Options/Communication.

What to do: configure a correct address for the data interface.

A line coupler is configured incorrectly

What to do: Scan line by line.

There are special devices for the purpose to inhibit programming and read-out of devices on the
bus. 

Try to read a device with the ETS function Device Info (you can determine the address as above
via programming mode). If that does not work, such a device might be the cause.

What to do: you have to locate (that's the difficult part) and remove the interfering device.

The installation contains only one physical line (no line couplers) but the devices have
addresses with different line parts (e.g.: 1.1.3, 1.2.5, 1.4.200). 

Such an installation does not confor to the KNX/EIB topology; reconstruction therfore cannot
determine the topology.

What to do: Enter the topology manually in reconstruction (Edit > Add area/line)
- or -
Change the local address for each of the "lines" e.g. for 1.1.3 to 1.1.x, for 1.2.5 to 1.2.x etc.
- or -
Correct the device addresses using ETS before using reconstruction.
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1.4.2 Why can't devices be read out?

In some cases the reconstruction will possibly fail or will be incomplete:

Possible causes:

The Device is locked with a BCU password.

What to do: delete BCU password.

The Device uses a PlugIn software (supplementary software).

Such devices can be only read out and reconstructed, if the device manufacturer supports
this (with an appropriate Reconstruction Plugin).

Some application programs contain parameters, which are not programmed into the Device
(e.g. comments on the documentation). These functionally insignificant parameter values
cannot be reconstructed therefore.

Application programs may exist, whose complex parameter dependencies can be not
completely dissolved by IT Reconstruction. In this case, IT Reconstruction dispalys an
appropriate message.

What to do: Contact our Support in this case, we will then try to find a solution.

1.4.3 Which data can be recovered?

Topology (areas and lines)
Devices

Individual address

Used application program

Parameter settings

Communication object flags and priority

Assigned group addresses

Group addresses

1.4.4 Which data can't be recovered?

Building and function structure

Names and descriptions of areas, lines, devices and group addresses
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1.4.5 Where do I find suitable product data?

Import the current product databases of the listed manufacturers.

On the product CD you will find a database with all registered products of all manufacturers.

If that does not help: Ask the product manufacturer; with the help of the Application Program ID,
they may be able to provide you with the missing data.

1.4.6 Why is the product data needed?

IT Reconstruction 1.x needed product data only in the reconstruction step. For some device classes
(e.g. BCU1 based devices), this works with  IT Reconstruction 2.x, too, but we recommend to import the
product data first in all cases for the following reasons:

Devices with external processor can in general not be read completely without product
data, even if they report mask version $001x, because they normally contain additional
memory ranges.

Devices with ETS Plug-ins can in general only be read with the help of special
Reconstruction Plug-ins, because they have possibly different memory layout.

BCU2 and BIM M112 based devices can be read much faster with product data, because
the relevant memory ranges can be accessed selectively.
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